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1. Przeznaczenie stanowiska Movie Diagnostics 

Movie Diagnostics jest systemem kontroli percepcji ruchomego obrazu umożliwiającym testy metodami 
okulograficznymi czyli śledzącymi i rejestrującymi ruchy oczu obserwatora. 

Okulografia  - znany z literatury angielskojęzycznej eye-tracking to ogół technik badawczych 
polegających na obiektywnym śledzeniu i rejestrowaniu ruchu gałek ocznych, najczęściej w celu 
uzyskania informacji o ścieżce utworzonej w czasie wodzenia wzrokiem po oglądanym obrazie, 
przedmiocie – lub mówiąc ogólnie – w czasie patrzenia. 

Dzięki zastosowaniu okulografii rejestrowane są dwa rodzaje danych:
1.  fiksacje, czyli punkty, w których wzrok się zatrzymał, 
2. sakkady, czyli ruchy oczu, podczas których wzrok jest przenoszony z jednego punktu obserwacji do

kolejnego. 
Najważniejszą zaletą zastosowania tej metody jest możliwość obiektywnego zbadania aktywności 
percepcyjnej odbiorców/obserwatorów, a w efekcie wnioskowanie o zachodzącym procesie percepcji.
Uzyskane dane otrzymane w wyniku zastosowanej metody dostarczają odpowiedzi na następujące pytania:

●  jak długo odbywa się obserwowanie wybranych, interesujących elementów/obiektów;
●  w jakiej kolejności odbiorca je dostrzega; 
● które elementy są zauważone, a które zignorowane; 
● jak często następuje powrót do postrzeganych elementów. 

Celem tak prowadzonej analizy jest określenie  ścieżek podążania wzroku co ułatwia ustalenia optymalnej 
struktury i dynamiki zmian obrazu w procesie śledzenia akcji i postrzegania, istotnych dla twórcy, 
elementów filmowej kompozycji.

Efektem zastosowania metody eye tracking są mapy cieplne (heatmaps), które sumują informacje 
dotyczące spojrzeń obserwatorów, oraz ścieżki skanowania (gaze plot) pokazujące fiksacje i sakkady.
Fiksacje (skupienia wzroku) i sakkady (przenoszenie wzroku od jednego elementu do kolejnego) 
umożliwiają zilustrowanie sposobu odczytywania, czyli postrzegania i oglądania danego obrazu, przez 
odbiorcę. W ostatnich latach wiele uwagi poświęca się właśnie sposobom postrzegania i patrzenia, co 
wynika z obserwowanego zjawiska kultury wizualnej, w której jedną z podstawowych zdolności człowieka 
jest kompetencja medialna bazująca na harmonijnej kompozycji pojmowania, zrozumienia i  
wartościowania postrzeganej inscenizacji.  

System Movie Diagnostics jest w pełni użytecznym stanowiskiem badawczym i pozwala na prowadzenie 
badań nad wizualnym postrzeganiem człowieka. 
Stanowisko może być wykorzystane do:

● badania obszarów atencji użytkownika i adaptacji scenariusza na etapie produkcji, pod kątem pełni 
przekazu (w praktyce zarządzanie punktem koncentracji widza w kontekście scenariusza); 

● oceny jakości obrazu stereoskopowego; 
● badanie aspektów psychologicznych percepcji obrazu stereoskopowego, tj. wpływ technik 

prezentacji obrazu 3D na zmęczenie, efekt nudności, koncentrację, gromadzenie wiedzy, itp.;
● badanie projektów interfejsów graficznych i sprzętowych na etapie wdrażania warstwy 

prezentacyjnej;
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Movie Diagnostics umożliwia przeprowadzenie badania na dowolnym materiale filmowym i wizualizację 
wyników (zarówno pojedynczych jak i zbiorczych) badań na tle tego materiału w synchronizowanym czasie.
Synchronizacja rejestracji parametrów fizjologicznych z konkretnymi ujęciami i obszarami prezentowanego 
przekazu filmowego stanowi obiektywną podstawę analizy reakcji widza na treść lub jakość obrazu. 
Elementem wspomagającym analizę jest ankietowanie subiektywnych odczuć widza w kluczowych dla 
badania fragmentach filmu.  

Możliwości jakie niesie ze sobą stanowisko obejmują:
● możliwość monitoringu danych biomechanicznych układu wzrokowego w trakcie oglądania ujęcia;
● monitorowanie punktu fiksacji wzroku w odniesieniu do obrazu, a tym samym akwizycji jego 

bieżących parametrów;
● analizę ujęcia filmowego pod kątem elementów przyciągających uwagę, a tym samym 

optymalizację prac postprodukcyjno-montażowych pod kątem głównie tych obszarów, na które 
widzowie zwracają uwagę;

● badanie oglądalności filmu (sposobu oglądania filmu przez widza).
Rolą poprawnie nakręconych obrazów filmowych jest wywołanie emocji, których doświadczanie 
przyciąga przed ekrany. Owe emocje zapewniają, że informacje zawarte w medium 
komunikacyjnym – obrazie filmowym będą odebrane oraz przyswojone;

● kontrolę jakości filmu 3D pod względem higieny i bezpieczeństwa oglądalności (zachowanie 
bezpiecznego budżetu paralaksy wzroku dla obrazu stereoskopowego). 
Autor zdjęć, operator kamery, stereografer oraz cały zespół techniczny w pionie operatorskim stają
przed wyjątkowo trudnym zadaniem pokonania przeszkód natury technicznej podczas filmowania 
w technice 3D, nie tracąc – na skutek błędów – emocjonalnej siły przekazu. Praktyka pokazuje, że 
błędy podczas produkcji są nieuniknione. Stanowisko badające fizjologiczną reakcję oka ludzkiego 
wsparte interaktywną ankietą (np. kliknięcie myszką) pozwoli oznaczyć momenty filmu, o 
określonych cechach (negatywnych lub pozytywnych) i skolaudować ich jakość w kontekście 
oczekiwanej percepcji. W praktyce przekłada się to na:

✔ zredukowanie ilości i typów błędów 3D powstałych w czasie rejestracji obrazu, 
✔ zmniejszenie ogólnego odsetku błędów stereoskopii na etapie postprodukcyjnym, 
✔ zmniejszenie kosztów czynności postprodukcji podnoszących jakość efektów 3D, 
✔ zwiększenie atrakcyjności i jakości percepcji filmu stereoskopowego.

Stanowisko Movie Diagnostics jest autonomiczne, kompletne i umożliwia: 
● przeprowadzanie badań jednostkowych i seryjnych, 
● kalibrację komponentów przed rozpoczęciem badania, 
● konfigurację badania pod określone cele, 
● gromadzenie i analizę danych, filtrowanie wyników i ich wizualizację. 

2. Komponenty stanowiska Movie Diagnostics

Stanowisko do badań okulograficznych składa się z dwóch podstawowych komponentów:
● komponentu do rejestracji zachowań i reakcji użytkowników (warunkowych i bezwarunkowych), 
● oraz komponentu, który pozwala na analizę i diagnozę zebranych podczas badania wyników. 
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Integralnymi elementami składowymi stanowiska CinemaVision Movie Diagnostics są:
● okulograf EyeTribe lub EyeX firmy Tobii,  
● kamera zewnętrzna (GoPro),
● monitor umożliwiający stereoskopową prezentację obrazu (3D), 
● laptop do uruchamiania systemu, rejestracji i prezentacji wyników badania,
● w przypadku projekcji 3D okulary polaryzacyjne. 

Moduł rejestrujący pozwala monitować obsługę stanowiska. Jeśli kalibracja stanowiska przebiegła 
niewystarczająco poprawnie lub podczas badania zebrane wyniki wskazują na istotne uchybienia i luki w 
rekordzie wyników,( np. zbyt duże przerwy pomiędzy kolejnymi pozycjami pomiarów wskutek utracenia 2-
3 pomiarów) lub  zbyt duża liczba błędów, to  wtedy możliwe jest powtórzenie badania bez zapisu.

2.1. Komponent rejestracyjny 
Komponent do rejestracji parametrów postrzegania, czyli punktu fiksacji, średnicy źrenicy  oraz 
częstotliwości mrugnięć  rejestruje zadane cechy z możliwe dużą częstotliwością i dokładnością. 
Częstotliwość pomiarów wynika z prędkości ruchu gałek ocznych (przy normalnym śledzeniu to około 
70°/s) oraz towarzyszących im sakkad o prędkości sięgającej 500-700°/s i amplitudzie 20° oraz czasie 
trwania od 25 do 100 ms. (Dla  1° sakkady 25 ms, a dla 15° sakkady 50 ms). 
Innym wskaźnikiem zachowania oka jest częstotliwość mrugnięć, która wynosi średnio 15 razy na minutę, 
ale może wzrastać do 25 razy na minutę (0.4 Hz) przy intensywnej, zaangażowanej rozmowie i spaść do 6 
razy na minutę (0.1 Hz) przy oglądaniu telewizji. Czas trwania mrugnięcia waha się od 100 do 300 (400) ms. 

Stanowisko umożliwia użycie najpopularniejszych i ogólnodostępnych na rynku urządzeń do śledzenia 
zachowania gałek ocznych. Urządzenia wkomponowane w stanowisko do badań jakości obrazu 3D to 
Eyetribe i EyeX firmy Tobii.
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Urządzenie do badania ruchów gałki ocznej EyeTribe firmy The EyeTribe

Urządzenie do badania ruchów gałki ocznej EyeX firmy Tobii

Wykorzystane urządzenia, sprzedawane są jako niskobudżetowe okulografy. Wszystkie nominalne 
parametry rejestracji są zgodne z wymaganiami częstotliwości i dokładności rejestracji. 
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Schemat działania stanowiska badawczego opartego o urządzenie EyeTribe 

Działanie urządzeń oparte jest o światło podczerwone, emitowane z urządzenia oraz odpowiedniej kamery,
która rejestruje punkty odbicia światła na rogówce oka. Na tej podstawie szacowana jest pozycja punktu 
koncentracji wzroku (ang. gaze point). W przypadku urządzenia EyeTribe specyfikacja, nie bezpośrednio, 
pozwala na rejestrację średnicy źrenicy oka. W przypadku EyeX możliwe dodatkowo jest precyzyjniejszy 
pomiar mrugnięć. 

2.1.1. Rozwiązanie „The EyeTribe” 

Strona umożliwiająca zakup urządzenia EyeTribe (zakup tylko przez internet): 
https://theeyetribe.com/products/

Uwaga! Po zakupie urządzenia udostępniany jest na portalu EyeTribe dostęp do pakietu 
instalacyjnego  urządzenia (system Windows).

Gotowe oprogramowanie w postaci  zbioru bibliotek SDK do zbudowania aplikacji wykorzystującej 
EyeTribe'a składa się z 2 głównych części: 

● Serwera odpowiadającego za komunikację z urządzeniem i interpretację otrzymanych od niego 
danych. Ten element jest udostępniany do pobrania (aktualizacji) przez producenta po zakupie 
urządzenia. Pobieranie plików SDK jest możliwe dla posiadaczy zarejestrowanego konta zakupu na 
portalu producenta; 

● Klienta komunikującego się z serwerem w celu pobrania od niego gotowych wyników, takich jak 
pozycja punktu skupienia wzroku, czy średnica źrenicy. Ten element jest zaimplementowany w 
pakiecie instalacyjnym CinemaVision Movie Diagnostics:

Pakiet instalacyjny CinemaVision Movie Diagnostics do pobrania (bezpłatnie): 
http://cinemavision.com/storage/app/media/software/mdiag-1.3  .msi
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Diagram architektury modułu rejestrującego opartego o urządzenie EyeTribe 

Aplikacja EyeTribe Server (uruchomiona i działająca w tle) gotowa do gromadzenia danych 
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Nawiązanie komunikacji z serverem EyeTribe  przez moduł rejestrujący ETRecorder 

Komunikat braku instalacji EyeTribe SDK. ETPlayer nie ma komunikacji z serwerem.

2.1.2. Moduł rejestrujący ETRecorder 

Zadaniem modułu rejestrującego jest zapisanie z zadaną częstotliwością (30 lub 60Hz, czyli co 33 lub 16 ms)
następującego rekordu danych:

● kolejna milisekunda badania będąca jednocześnie milisekundą odtwarzanego filmu;

8



CV.MD.QS PL - Movie Diagnostics Wprowadzenie 

● oszacowana współrzędna x i y punktu koncentracji wzroku;
● stan urządzenia wskazujący, czy oczy są otwarte/zamknięte, lub czy ewentualnie wykryto błąd;
● średnica źrenicy;
● fakt kliknięcia myszką mogący kodować różne formy opisu testowanego materiału (np. błędy w 

filmie).

Do przeprowadzenia badania służy aplikacja ETRecorder.

Aplikacja ETRecorder umożliwia wykonywanie następujących operacji: 
● konfigurowanie urządzenia, 
● kalibracja urządzenia pod konkretnego użytkownika, 
● pobieranie wyników, 
● nasłuchiwanie zmian w konfiguracji i stanie urządzenia (np. urządzenie zostało odłączone lub nie 

udało się znaleźć użytkownika w polu widzenia kamery),
● uruchamianie drugiej aplikacji ET Player (odtwarzacza) – zarówno w celu przeprowadzenia badania 

jak i obejrzenia wizualizacji wyników, 
● synchronizacja czasu pomiędzy aplikacjami ETRecorder i ETPlayer, 
● zbieranie i przetwarzanie danych otrzymanych od obu wymienionych programów – aplikacja musi 

połączyć dane na temat osoby badanej (punkt skupienia wzroku, średnica źrenicy itp.) z 
informacjami od odtwarzacza (aktualny czas filmu, momenty oznaczone przez użytkownika jako 
interesujące, informacja o zakończeniu filmu).  

Dane zbierane przez aplikację po przeanalizowaniu każdej klatki to: 
● aktualny czas, 
● stan urządzenia (czy jest podłączone, czy znaleziono oczy użytkownika itp.), 
● czy wzrok użytkownika jest skupiony, 
● nieprzefiltrowana pozycja punktu skupienia wzroku z aktualnej klatki, 
● uśredniona z obu oczu i przefiltrowana pozycja wzroku z ostatnich kilku klatek, 
● przefiltrowana i nieprzefiltrowana pozycja punktu skupienia wzroku dla prawego i lewego oka, 
● rozmiar źrenicy prawego i lewego oka, 
● pozycja źrenicy prawego i lewego oka wewnątrz bryły widzenia kamery. 

Aby pomiar charakterystyk ludzkiego wzroku podczas badania był wiarygodny niezbędna jest uprzednia 
kalibracja stanowiska dostosowana do każdego oglądającego i do zmieniających się warunków otoczenia. 
Stanowisko w celu zwiększenia wiarygodności pomiarów punktów koncentracji wzroku widzów oraz 
poprawnego rejestrowania mrugnięć oczyma, wyposażone jest w dodatkowy rejestrator obrazu twarzy 
ludzkiej (kamera GoPro), którego zadaniem jest zsynchronizowane z odtwarzaniem materiału testowego 
nagrywanie obrazu twarzy podczas badania.
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Moduł rozszerzający stanowisko o rejestrator obrazu twarzy ludzkiej 

Aplikacja ETRecorder umożliwia przeprowadzenie badania na dowolnym materiale filmowym 
(obsługiwanym przez zestaw kodeków Direct Show), jak również uruchomienie drugiej aplikacji ETPlayer w 
celu obejrzenia wizualizacji wyników (zarówno pojedynczych jak i zbiorczych) badań. 

Aktualne kodeki Direct Show do pobrania: 
http://www.codecguide.com/download_kl.htm 

2.2. Komponent wizualizacji (ETPlayer)
Drugim istotnym komponentem systemu badania percepcji obrazu jest moduł do wizualizacji i analizy 
danych pomiarowych. 
Komponent zbudowany jest jako odtwarzacz wideo korzystającego z technologii DirectShow. Uniezależnia 
to użytkownika od konkretyzowania formatu danych wideo pod warunkiem dostarczenia odpowiednich 
kodeków do używanego systemu operacyjnego. 

Moduł zapewnia cztery zasadnicze tryby pracy: 
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BAZOWY – odtwarzacz wideo zapewniający podstawowe funkcje takiej aplikacji, które również w całości 
lub w części realizowane są w pozostałych trybach:

 otwarcie/zamknięcie pliku filmowego,
 pauzowanie/wznowienie odtwarzania,
 przewijanie nagrania,
 zarządzanie ujęciami,
 wyświetlanie dodatkowej, powiększonej wizualnie informacji o aktualnym czasie iujęciu 

odtwarzania.

RECORD – odtwarzanie podczas badania:
 odtwarzanie na pełnym ekranie,
 skierowanie odtwarzania na dowolny monitor podłączony do systemu komputerowego,
 wybór fragmentu nagrania (punktu startowego i końcowego),
 rejestracja akcji –wciśnięć przycisku myszki przez widza.

SINGLE – wizualizacja wyników pojedynczego badania:
 przewinięcie do poprzedniej/następnej nagranej akcji.

MULTI – wizualizacja wyników wybranych badań w dowolnej liczbie (opcje dostępne są również w trybie 
SINGLE):

 otwieranie plików z nagraniami (jednego lub wielu –wpływa to automatycznie na tryb działania 
odtwarzacza),

 filtrowanie danych –pomaga w obserwacji zmian podczas analizy materiału,
 uwzględnienie czasu skupienia –pozwala na zmianę sposobu prezentacji wyników,
 skalowanie wyświetlanego obrazu wraz z ucięciem –prezentuje tylko jeden obraz z pary stereo, 

gdy jest to wystarczające do analizy wyników.

Głównym zadaniem komponentu odtwarzacza jest wizualizacja wyników badań w trybie nie powodującym 
opóźnień. Duża liczba wizualizowanych rekordów z wynikami badań, które wymagają często bieżącej (w 
locie) analizy i interpretacji stanowi istotne wyzwanie dla aplikacji. 
Poza eliminacją opóźnień, z punktu widzenia analizy, niezbędna jest swoboda agregacji uzyskanych danych 
testowych (wybór podzbioru danych pomiarowych), ich synchronizacja oraz zrozumiała i intuicyjna 
prezentacja. 

Wizualizowane są:
Dla pojedynczego badania:

● punkt koncentracji wzroku,
● średnica źrenicy, 
● fakt mrugnięcia oczyma,
● kliknięcie myszką dla zaznaczenia charakterystycznego momentu.
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Podczas odtwarzania wyników pokazywany jest okrągły znacznik złożony z kilku elementów wizualizujących
parametry zmierzone w badaniu:

● pozycja znacznika pokazuje punkt fiksacji zarejestrowany przez okulograf,
● zielony pierścień – wewnętrzna średnica pokazuje wielkość źrenicy,
● zielone koło pokazuje zamknięcie oka,
● zewnętrzna średnica turkusowego pierścienia pokazuje czas skupienia – powiększa się z każdą 

klatką, w której położenie znacznika jest bliskie poprzedniemu,
● czerwone koło pokazuje akcję użytkownika (kliknięcie przyciskiem myszki).
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Podczas odtwarzania nagrania dla analizy wielu rekordów danych (wielu badań) pokazywane są:
● obszar koncentracji wzroku (w postaci mapy cieplnej),
● mediana średnic źrenicy, 
● poziom istotności pomiaru średnicy źrenicy (odchylenie standardowe), 
● częstotliwość mrugnięć w odniesieniu do ujęcia,
● liczba kliknięć myszką w danym ujęciu.
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Spośród metod wizualizacji obszarów obrazu o różnym poziomie istotności jedną z najpopularniejszych jest
metoda mapy cieplnej (heatmap). 

Mapa cieplna - Jeden ze sposobów wizualizacji danych otrzymanych dzięki badaniom z 
wykorzystaniem metodologii eyetracking. Pokazuje uśredniony obraz tego, ile uwagi osoby badane 
poświęcały poszczególnym elementom badanego bodźca.

Pełna analiza danych (z dokładnością do poszczególnych klatek) wymaga możliwości zatrzymania filmu w 
dowolnym momencie (na dowolnej klatce filmu) i wznowienia odtwarzania materiału oraz przewinięcia 
materiału filmowego do dowolnego momentu. Zadanie to realizowane jest za pomocą suwaka w 
ETPlayerze, który działa podobnie jak w większości odtwarzaczy filmów, (ale umożliwia przeskok o jedną 
klatkę). 
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Oprócz analizy punktu koncentracji stanowisko umożliwia wizualizację częstotliwości mrugnięć z powodu 
silnej korelacji częstotliwości mrugnięć z komfortem wizualnym dla ruchu obiektów/kamery w płaszczyźnie 
ekranu i ruchu obiektów/kamery w głąb sceny. 
Analiza częstotliwości mrugnięć ma sens w kontekście poszczególnych ujęć. Podobnie sytuacja ma się 
względem punktów kliknięcia myszką, które opisują momenty filmu, które obserwator chciał w określony 
sposób ocechować.
Także średnica źrenicy, która zwracana jest dla każdej klatki ma przełożenie na ocenę komfortu wizualnego 
widza. 

Techniczne parametry przeprowadzenia badania, które wspiera moduł wizualizująco-analityczny to:
● kadrowanie obrazu stereoskopowego jeden nad drugim (one over another) do jednej jego części 

(obrazu lewego lub prawego oka), aby możliwa była pełnoekranowa analiza wyników;
● parametry filmu testowego (numer ujęcia, milisekunda filmu, ilość kliknięć myszką)  umieszczone 

są w lewym dolnym rogu z możliwością ich wyłączenia;
● wybrane parametry wyświetlania mapy cieplnej i filmu testowego są dostępne  z pliku 

konfiguracyjnego;

2.2.1. Filtrowanie danych

Komponent w trybach SINGLE i MULTI może odtwarzać dane nagrane lub przefiltrowane. 
Filtracja pomaga w ręcznej analizie danych poprzez bardziej przystępne wizualizowanie wybranych 
parametrów:

● punktu fiksacji – obliczana jest średnia ruchoma z żądanej liczby poprzednich pomiarów,
● czasu skupienia – podany promień służy określeniu, czy pozycja wdanej klatce jest uznawana za tę 

samą, co w poprzedniej, czy inną; jeśli pozycja jest ta sama, to czas skupienia zwiększa się,
● rozciągnięcie akcji –znacznik akcji jest wyświetlany przez zadeklarowany czas, a nie tylko w klatce 

filmu, w której widz kliknął myszką; pozwala to na łatwiejsze znalezienie punktów kliknięcia.

Odtwarzacz pozwala w każdej chwili i w każdym trybie przełączyć się między danymi filtrowanymi i 
niefiltrowanymi.

2.2.2. Uwzględnienie czasu skupienia

Czas skupienia, a więc długość okresu, w których punkt fiksacji był wystarczająco podobny (mieścił się w 
zadanym promieniu) do bieżącego jest wizualizowany:

 w trybie SINGLE - domyślnie przy pomocy zmiany wielkości turkusowego pierścienia,
 w trybie MULTI - poprzez wybór odpowiedniej opcji. Wtedy heatmapa jest tworzona na bazie sumy kół, 

których średnice zwiększają się dynamicznie wraz ze wzrostem czasów skupienia odpowiadających im 
badań.
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2.2.3. Plik konfiguracyjny

Ze względu na możliwości parametryzowania algorytmów działających w komponencie odtwarzacza 
aplikacja korzysta z pliku konfiguracyjnego ETPlayer.ini zawierającego zbiór ustawień, których domyślne 
wartości może ustawić użytkownik (właściciel badania):

Sekcja [Navigation]:
● timeStep – liczba całkowita milisekund o ile minimalnie można przewinąć film posługując się 

klawiaturą, domyślnie 25 ms,

Sekcja [Preprocessing]:
● eventsNum – liczba całkowita próbek dla średniej ruchomej przy filtrowaniu, domyślnie 8,
● filterRadius – liczba całkowita, promień dla obliczania czasu skupienia, podany wmilionowych 

rozmiaru ekranu, domyślnie 20000,
● actionRadius – liczba całkowita określająca liczbę milisekund, o ile wydłużyć czas wyświetlania 

znacznika akcji, domyślnie 500.

Sekcja [Results]:
● pupilStandardDeviationPercentTreshold – liczba całkowita procent, poniżej których 

zejście odchylenia standardowego średnicy źrenicy jest sygnalizowane podświetleniem znacznika 
(fioletowego paska), domyślnie 60,

● viewScaleXPercent, viewScaleYPercent – współczynniki skalowania dla trybów 

16



CV.MD.QS PL - Movie Diagnostics Wprowadzenie 

wyświetlania wyników (SINGLE i MULTI), (w przypadku pracy z filmami stereo w konfiguracji jeden 
nad drugim przydatne może być ustawienie viewScaleYPercent=50), domyślnie 100 i 100.

Progi procentowe dla kolejnych kolorów heatmapy:  
● heatMapPercentThresholdCyan, domyślnie 25, 
● heatMapPercentThresholdGreen, domyślnie 50, 
● heatMapPercentThresholdYellow, domyślnie 75, 
● heatMapPercentThresholdRed, domyślnie 100.

Promienie okręgów budujących heatmapę: 
● heatMapCircleDiameterConst -  gdy nie jest uwzględniany czas skupienia, domyślnie 10,
● heatMapCircleDiameterStart - początkowy promień przy minimalnym czasie skupienia, 

domyślnie 2,
● heatMapCircleDiameterStep -  krok powiększania promienia z każdą klatką skupienia, 

domyślnie 1.

Plik konfiguracyjny umieszczony jest w katalogu: 
...%APPDATA%\Roaming\CinemaVision

3. Obsługi stanowiska 

3.1. Obsługa komponentu rejestrującego stanowiska 

Korzystanie z tego komponentu dzieli się na kilka etapów: 
● podłączenie i konfiguracja urządzenia, 
● przeprowadzenie badania, 
● wizualizacji wyniku badania. 

3.1.1. Podłączenie i konfiguracja urządzenia 
Przed uruchomieniem aplikacji umożliwiającej przeprowadzenie badań, należy podłączyć okulograf 
EyeTribe. 
Ważne jest, aby został on podłączony do portu USB 3.0 (w przeciwnym wypadku nie będzie działał).
Następnie można uruchomić aplikację ETRecorder. Na starcie organizuje się środowisko  EyeTracker do 
zbierania danych okulografu (EyeTribe Server).
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Jednocześnie otwiera się okno aplikacji ETRecorder. 
Aplikacja pracuje na jednym oknie podzielonym na zakładki w celu łatwiejszego przechodzenia do 
kolejnych etapów badania. 
Po uruchomieniu programu aktywna jest pierwsza z nich - „Kalibracja”: 
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Umożliwia ona sprawdzenie stanu EyeTribe'a, ustawienie jego częstotliwości działania, jak i również 
przeprowadzenie kalibracji. 
Co ważne zmiana częstotliwości powoduje zrestartowanie urządzenia, dlatego nie można wykonywać jej 
w czasie badania lub kalibracji. 
Aplikacja po starcie automatycznie uruchamia „EyeTribe Server” (program odpowiedzialny za komunikację 
z urządzeniem). W przypadku problemów z wyżej wymienionym programem lub samym problemem, 
można go zrestartować klikając przycisk „Restart serwera”. 

3.1.2. Kalibracja okulografu
Krokiem koniecznym do przeprowadzenia badań jest kalibracja urządzenia pod danego użytkownika. 
W tym celu należy kliknąć przycisk „Kalibracja”, a następnie skorzystać z programu dołączonego do 
EyeTribe'a: 

19



CV.MD.QS PL - Movie Diagnostics Wprowadzenie 

Ważne jest aby oczy użytkownika znajdowały się mniej-więcej w środku obszaru po lewej stronie okna. 
Tło, na którym oczy są wizualizowane jest wtedy zielone – oznacza to, że oczy znajdują się w dobrym 
miejscu – można przejść do kalibracji. 

Kalibracja polega jedynie na podążaniu oczami za punktem wyświetlonym na ekranie: 

W czasie kalibracji można mrugać oczami, jednak należy unikać ruchów głową – za punktem należy 
podążać poruszając jedynie oczami. W trakcie badania (po kalibracji) można już ruszać głową. 
Ważne jest aby po zakończeniu kalibracji zamknąć narzędzie służące do kalibracji. 
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Stanowisko w celu zwiększenia wiarygodności pomiarów punktów koncentracji wzroku widzów oraz 
poprawnego rejestrowania mrugnięć oczyma, wyposażone jest w dodatkowy rejestrator obrazu twarzy 
ludzkiej (kamerę GoPro), którego zadaniem jest zsynchronizowane nagrywanie obrazu twarzy podczas 
badania. 

Dodanie kamery nagrywającej badaną osobę umożliwia późniejszą weryfikację mrugnięć, jak i również (w 
mocno ograniczonym stopniu) stwierdzenie na ile badana osoba była zainteresowania oglądanym 
materiałem. Możliwe jest również wykorzystanie tych nagrań do stwierdzenia czy ew. błędy w 
rejestrowanych danych (np. brak próbek przez kilka sekund, lub błędne rozpoznanie mrugnięcia) wynikały z
niedokładności samego systemu czy z czynników zewnętrznych (np. użytkownik zasłonił twarz ręką). 
Takie działanie pozwala zinterpretować zachowania widza mogące świadczyć o jego stanie emocjonalnym 
w celu znalezienia spójności pomiędzy emocjami a sposobami obserwacji obrazu. Tak zrealizowane badania
jakościowe, stosowane są w etnografii wizualnej i sensorycznej. Pozwalają na śledzenie oczu w 
odpowiednim kontekście. Obraz twarzy i mapa cieplna reprezentująca punkt skupienia wzroku widza 
pozwala na swego rodzaju most między uwagą a reprezentacją wizualną linii wzroku. 

Aby uaktywnić nagrywanie za pomocą kamery GoPro należy:
● uaktywnić podłączenie kamery do tej samej sieci Wi-Fi, do której podłączony jest komputer 

sterujący badaniem (za pomocą ustawień Settings w kamerze GoPro),
● przejść do trybu nagrywania filmu w kamerze,
● w Oknie ETRecorder / Kalibracja zaznaczyć dodatkowe nagrywanie kamerą GoPro,
● podać hasło podłączenia kamery do Wi-Fi.

Reasumując: 
Przed przeprowadzeniem badania należy sprawdzić, czy urządzenie jest w pełni gotowe – jest tak w sytuacji
gdy serwer jest uruchomiony („EyeTribe Server uruchomiony: Tak”), urządzenie jest podłączone („Stan 
EyeTribea: Podłączony”) i skonfigurowane (jakość kalibracji jest większa lub ew. równa 3). Oczywiście przed
rozpoczęciem badania nowej osoby należy powtórzyć proces kalibracji. 
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3.1.3. Przeprowadzenie badania
W celu przeprowadzenia badania należy przejść do drugiej zakładki - „Badanie”: 

Pola do wypełnienia:
● wybór ścieżki dostępu do filmu testowego,
● wybór ścieżki dostępu do bazy danych z wynikami przeprowadzonego testu,
● Dane badanego (record z wynikami testu dla badanego będzie zawierał w nazwie wpisane id).

Większość z pól wystarczy wypełnić tylko raz dla każdego badanego materiału. 
Pole „Identyfikator” - w to miejsce należy wpisać dowolny ciąg znaków, który będzie identyfikował dane 
badanie. Może to być zarówno imię i nazwisko badanej osoby, jak i numer, czy nawet losowy ciąg znaków –
teoretycznie nie ma to większego znaczenia, aczkolwiek wybranie prostego i logicznego sposobu nazywania
kolejnych badań niewątpliwie ułatwia późniejszą analizę badań. 

22



CV.MD.QS PL - Movie Diagnostics Wprowadzenie 

W dolnej części okienka widoczny jest suwak („Progres: ”). Pokazuje on na jakim etapie badania aktualnie 
jesteśmy (jego lewa krawędź to początek, a prawa to koniec), jak i również wyświetla informacje o 
kliknięciach myszką przez użytkownika.  

Pionowe, grube, czarne kreski symbolizują informację zwrotną od użytkownika (klikniecie myszą), a strzałka
– moment badania, w którym aktualnie jesteśmy. 

Po zakończeniu badania (w sposób naturalny lub wymuszony) wyświetlane jest następujące okienko: 

Prezentuje ono statystyki badania, umożliwiające ocenę jakości samego badania (nie mylić z oceną jakości 
badanego materiału) i ew. odrzucenie badań nie spełniających określonych kryteriów. 

Zalecane wartości prezentowanych parametrów to: 
● procent nieprawidłowych próbek – maks. 10%; 
● rzeczywisty FPS – wartość możliwie zbliżona do wartości wybranej na poprzedniej zakładce. 

Maksymalna rozbieżność to ok. 15%; 
● najdłuższa przerwa pomiędzy próbkami – 250 ms; 
● najdłuższa przerwa pomiędzy poprawnymi próbkami – 1500 ms; 
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3.1.4. Wizualizacji wyników badania 
Są 2 tryby wizualizacji:

● pojedyncza (bazująca na jednym badaniu)
● zbiorcza (bazująca na wielu badaniach). 

Uruchomienie komponentu wizualizującego (ETPlayera) generuje pojawienie się podstawowego okna:

Umożliwia ono w podstawowym zakresie obsługę analizowanych materiałów i danych, bądź uruchomienie 
nowej rejestracji (menu File). 
Wczytanie analizowanego pliku video (File →  Open examined movie) powoduje pojawienie się okna 
wyboru pliku video.
Opcja wczytania danych (File → Open examination results) z badań pozwala na swobodne wybranie liczby 
wcześniej zarejestrowanych rekordów badań (pojedynczego, wybranych lub wszystkich)

Obsługa odtwarzania materiału video inicjuje tryb BAZOWY zawierający następujące opcje: 
● File → Open examined movie (skrót klawiszowy ^O) – otwarcie pliku z filmem, 
● File → Close examined movie (klawisz Esc) – zamknięcie pliku z filmem, 
●  File → Open examination results (skrót klawiszowy ^D) – otwiera plik lub grupę plików z 

nagraniami, 

● (klawisz Spacja) – start/pauza/wznowienie odtwarzania, 
● klawisz F – przełączanie trybu pełnoekranowego (Fullscreen),

● czas w formacie 00:00:00:000 – aktualny czas w odtwarzanym filmie. 

Użytkownik może w każdym momencie przerwać analizę wyników badań i włączyć komponent rejestracji 
wyników, tzw. tryb RECORD pozwalający na wykonanie kolejnego badania na tym samym materiale 
filmowym:

● File → Start new examination – przechodzi do komponentu ETRecorder.
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Podczas  wizualizacji badania na tle testowego filmu można nawigować po osi czasu za pomocą komend i 
skrótów klawiszowych:

● Navigation →  Pause / resume (klawisz Spacja) – wstrzymanie / wznowienie odtwarzania.
● Navigation →  Step forward / Step backward (strzałka w prawo / strzałka w lewo )- przesuwanie się

na osi czasu filmu  o wartość timestep (ustawiana w pliku ETPlayer.ini – domyślnie 0,25 
sekundy). W praktyce służy do przeglądania interesującego fragmentu badania w sposób zbliżony 
do poklatkowego .

● Navigation →  Jump forward/ Jump back (klawisze Ctr+strzałka w prawo / Ctr+strzałka w lewo) –
przeskok o 15 sekund do przodu / tyłu. W praktyce służy do szybkiego przejrzenia całości badania.

● Navigation →  Prevoius keypoint / Next keypoint (klawisze R / T) –przeskok do poprzedniego / 
następnego momentu kliknięcia myszą przez badanego.

● Navigation →  Slower  – zwolnienie tempa odtwarzania o 10%. Kolejne użycie komendy zwalnia 
odtwarzanie o kolejne 10%. Ułatwia analizę wyników i uchwycenie trendów zwłaszcza w trybie 
MULTI.

● Navigation →  Normal playback  – powrót do normalnej prędkości odtwarzania. 
● Navigation →  Faster  – przyspieszenie tempa odtwarzania o 10%. Kolejne użycie komendy 

przyspiesza odtwarzanie o kolejne 10%. Ułatwia szybkie przejrzenie wyniku badania w celu oceny 
jego poprawności zwłaszcza dla długiego badanego materiału .

● Slider →  trackbar na dole okna głównego – przesuwanie powoduje przemieszczanie się na osi 
czasu filmu w przód i w tył w nieskwantowany (ciągły) sposób.

Do przemieszczania się pomiędzy wydzielonymi ujęciami (shotami) służą klawisze  > (w przód) lub < (w tył). 
Szczegóły Menu  →  Shots.
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Jeśli przeglądany jest aktualnie jeden rekord z danymi tzw. tryb SINGLE, to śledzimy wyniki badania jednej 
osoby wybranej z listy przebadanych osób (wizualizowane są: punkt koncentracji, średnicę źrenicy, fakt 
mrugnięcia okiem, fakt kliknięcia muszką).
Jeśli wczytano do analizy wiele rekordów danych pomiarowych (tryb MULTI),to istnieje możliwość 
modyfikacji trybu i sposobu wyświetlania dzięki opcjom menu Analyse.

Możliwości  modyfikacji trybu i sposobu wyświetlania wyników badania:

● Analyse → Consider focus time – uwzględnienie nakładania się czasu skupienia w badaniach w 
heatmapie w trybie MULTI,

● Analyse → Adjust screen horizontally/ Adjust screen vertically – przystosowanie okna prezentacji 
wyników dla filmu 3D, z którego do analizy wybrany jest tylko jeden obraz z pary,

● Analyse → Default screen – podstawowe okno wyświetlania, przystosowanie do filmu 2D i jego 
ro\dzielczości,

● Analyse → Show focus heatmap – włącza / wyłącza pokazywanie mapy cieplnej koncentracji 
wzroku,

● Analyse → Show keypoints – włącza / wyłącza pokazywanie momentu kliknięcia myszką,
● Analyse → Show pupil size – włącza / wyłącza pokazywanie kości źrenicy badanego,
● Analyse → Fast / Accurate presentation – jakość grafiki prezentacyjnej dla wyników (zgrubna / 

wygładzona),
● Analyse → Single test result – pozwala wybrać tryb SINGLE, w przypadku wcześniejszego wczytania 

wielu badań (pokazywane będzie pierwsze badania z listy wskazań),
● Analyse → Multi tests result – pozwala wybrać tryb MULTI, w przypadku wcześniejszego wczytania 

pojedynczego badania (będzie ono prezentowało także wszystkie pozostałe badania z listy,
● Analyse → Data filtered – pozwala włączyć/wyłączyć tryb filtrowania danych.
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● View → Show Timeline / Shot counter – włącza/wyłącza widoczność dużego licznika osi czasu filmu 
oraz wskaźnika: numer Shota / ilość Shotów dla wszystkich ujęć zamarkowanych w filmie 
testowym.

Przy włączeniu wszystkich opcji możemy analizować:
1. zarówno wyniki z pojedynczego badania 
2. lub kilku badań za pomocą mapy cieplnej 
3. oraz średnicę źrenicy, 
4. liczbę kliknięć w danym ujęciu, 
5. śledzić bieżący czas filmu 
6. oraz numer bieżącego ujęcia.

Nim jednak możliwa będzie analiza per poszczególne ujęcie (Shot) należy film odpowiednio podzielić. 
Włączenie funkcji edycji ujęć (menu → Shot) pozwala na stworzenie nowego lub edycję istniejącego pliku z 
zapisanymi ujęciami. Proces ten musi być sterowany ręcznie, gdyż domyślnie film nie ma oznakowanych 
początków ujęć, a jest to istotne przy analizie niektórych parametrów.

Menu Shot (po wybraniu filmu) włącza edycję ujęć.
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Jeśli nie ma pliku ujęć, to zostanie on stworzony bez dodatkowych potwierdzeń (od tego momentu film 
składa się z jednego ujęcia numer 1).

 Jeśli plik istnieje, to zostanie wczytany - nawigacja oraz edycja ujęć staje się dostępna:
● Shot → Previous shot / Next shot (klawisz <, i >.) – przeskok do początku poprzedniego / 

następnego ujęcia,
● Shot → Start current shot (klawisz / ) – przeskok do początku bieżącego ujęcia,
● Shot → Loop current shot (klawisz / ) – odtwarzanie w pętli wyników dla bieżącego ujęcia. 

Funkcjonalność przydatna do wnikliwej analizy wyników dla konkretnego ujęcia,
●  Shot → Add / remove shot  klawisz + (plus) –dodanie znacznika ujęcia w bieżącym momencie 

filmu,
● Shot → Add / remove shot  klawisz - (minus) –usunięcie znacznika ujęcia z bieżącego miejsca,
● wyłączenie menu Shot powoduje zapisanie wszystkich zmian do pliku ujęć i wyłączenie edycji i 

nawigacji po ujęciach. Ponowne załadowanie filmu uaktywnia nowe ustawienia.
● # n / nn na liczniku – aktualny numer ujęcia w stosunku do liczby wszystkich ujęć (klawisz ?/) – 

przewinięcie do początku bieżącego ujęcia,

Przykładowy podział filmu na Shoty (ujęcia):

nr początek koniec opis
1 0:00 0:04 napis pojawia się
2 0:04 0:12 pod napisem pojawia się tło - paralaksa
3 0:12 0:14 napis znika - czerń
4 0:14 0:17 kamera - ujęcie statyczne
5 0:17 0:23 pojawiają się napisy
6 0:23 0:29 kamera - ujęcie statyczne, napisy
7 0:29 0:32 napisy na czarnym tle
8 0:32 0:36 interfejs programu
9 0:36 0:42 scena leśna, ruch obiektu w prawo
10 0:42 0:46 bliskie ujęcie na drzewo, delikatny ruch kamery w prawo
11 0:46 0:47 mechanizm, delikatny obrót kamery w lewo
12 0:47 0:52 park, zmiana przesłony
13 0:52 0:56 człowiek, oddalenie kamery
14 0:56 0:58 interfejs programu
15 0:58 1:03 kamera, obrót obiektu w lewo
16 1:03 1:06 park, delikatny ruch kamery w prawo
17 1:06 1:09 roślinność szybki zoom
18 1:09 1:13 kamera, obrót obiektu w lewo
19 1:13 1:15 kora, zoom
20 1:15 1:17 kamera, obrót obiektu w lewo
21 1:17 1:23 kamera, ujęcie statyczne
22 1:23 1:26 liście, zmiana ogniskowej
23 1:26 1:28 interfejs programu
24 1:28 1:31 obiektyw, szybki ruch kamery w lewo i w prawo
25 1:31 1:33 liście, szybki zoom
26 1:33 1:36 2 obiektywy, obrót kamery w lewo
27 1:36 1:43 kamera, obrót obiektu w prawo
28 1:43 1:45 obiektyw, paralaksa
29 1:45 1:49 krajobraz, paralaksa
30 1:49 1:52 mechanizm
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31 1:52 1:56 krajobraz, szybki ruch kamery w prawo
32 1:56 1:59 mechanizm
33 1:59 2:06 kamera, obrót obiektu w lewo
34 2:06 2:15 końcówka

Ustawienie wersji językowej interfejsu użytkownika:

● Settings → Language →  wybór języka interfejsu. Zmiana wymaga ponownego uruchomienia 
ETPlayera,

4. Procedura badania
W celu standaryzacji i powtarzalności sposobu przeprowadzenia badań wskazane jest przygotowanie 
badanych osób do przebiegu i uwarunkowań badania. 

Przykładowe zagadnienia do omówienia przed rozpoczęciem badania:

1. Należy wyjaśnić badanemu cel i przebieg testu, jego czas trwania oraz kluczowe momenty.
2. Należy posadzić badanego tak aby przyjął komfortową pozycję pozwalającą na nieuciążliwe 

obejrzenie testowanego materiału (odległość od monitora i okulografu, odpowiednia powygodna 
pozycja na krześle). 

3. W przypadku testów na filmie 3D  należy poprosić badanego o założenie okularów polaryzacyjnych 
i skalibrować stanowisko badawcze tak, aby wynik kalibracji miała co najmniej 4 gwiazdki (skala do 
5). 

4. Należy zaprezentować badanej osobie cały materiał filmowy, bez konieczności zaznaczania 
punktów dyskomfortu / komfortu za pomocą myszy, jednak prowadząc rejestrację za pomocą 
okulografu. 

5. Po pierwszym obejrzeniu filmu należy zebrać ogólne wrażenia dotyczące obejrzanego materiału 
oraz wypełnić ankietę skonstruowaną w celu udokumentowania badania i stworzenia statystyki 
osiągniętych celów badawczych. 

6. Proszę poinstruować badanego, że druga część ma na celu precyzyjne zaznaczenie za pomocą 
myszki momentów filmu, które cechują się relatywnie niskim, bądź wysokim komfortem 
wizualnym (np.: niewyraźne postrzeganie sceny, problem zbyt dużej/małej głębi obrazu, 
dyskomfort wzrokowy, niewłaściwa głębia ostrości, artefakty kolorystyczne i inne). Każdy taki 
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moment należy zaznaczyć kliknięciem myszki podczas oglądania, a następnie krótko 
scharakteryzować ten fakt kliknięcia w ankiecie. 

Przykładowa ankieta może wyglądać następująco:

KONIEC
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